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SOP 1.01: Plankton Sampling Site Selection

I.  Summary

Originally, the criteria for routinely sampled sites were based primarily upon likely locations of
Dreissenid mussel introduction and propagation. The routine site list is comprised of
Wahweap Marina, Stateline Marina, Antelope Point Marina, Glen Canyon Dam, Bullfrog
Marina, Halls Crossing Marina, and Hite Marina. In the recent past when water levels were
too low to access and sample Hite Marina, Good Hope Bay was introduced as a replacement
uplake routine site.

As the Dressenid population in Lake Powell has spread throughout the body of water,
sampling protocols have evolved to meet the new needs of veliger monitoring and the
abilities of the laboratory. The below procedures reflect the changes.

. Procedures

A. Primary Sampling Sites:

i, The sites that are sampled on a monthly basis are areas where the risk of introducing
Dreissenid mussels were deemed highest prior to infestation. These areas of high risk
included marinas, with the exception of Dangling Rope Marina, because of the frequent
launching of vessels that may have been in infested waters previously. Because of the
extensive and consistent sampling efforts over time in these areas, they will remain part
of the Primary Sampling Sites.

ii. Outside the breakwater at Glen Canyon Dam is also considered a routine sampling site.
The water flow, hard substrates, and relative location on the lake increased its potential
exposure to settling veligers and its susceptibility to Dreissenid colonization. Because of
its extensive and consistent sampling efforts over time, this location will remain a
Primary Sampling Site.

B. Secondary Sampling Sites:
i As Lake Powell has become infested, there is less need for random sampling and more

need for monitoring the spread of the infestation, but sampling every infested Visitor Use
Zone on a monthly basis is not feasible. Instead, each infested Zone outside of the
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Primary Sampling Sites’ Zones will be sampled on a quarterly basis. Each Zone will have a
dedicated routine site location, similar to the Primary Sampling Sites.

C. Random Sampling:

i Random sampling is also done periodically to reduce sampling bias. Random sampling
sites are generated using GIS (refer to SOP 2.01: Random Plankton Sampling Site Selection

Using ArcMap).
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Attachments:
Plankton Tow Data Sheet (A)
Plankton Sampling Site ID Key (C)

SOP 1.02: Preparation for Plankton Sampling

Summary

The necessary preparations for plankton sampling are described below.

Equipment
Field sampling binder DI water
Plankton Tow Data Sheets DI water wash bottle
Plankton Sampling Site ID Key GPS unit
Black permanent marker & pen Plankton net & cod-end
Field thermometer Line (marked every 1 meter) & reel
Sample bottles (125ml, 250ml) Hach meter handheld unit
Ethanol, 95% denatured with methyl & Hach meter dissolved oxygen probe
IPA Hach meter pH probe
White distilled vinegar Hach meter conductivity probe
Vinegar spray bottle 12 AA batteries
Procedures
A. Reserve the boat you wish to use on Google Calendar.
B. Determine the sites to be sampled, and the number of samples per site to be collected -
bring enough sample bottles for these samples and a few extras.
C. Bring a spray bottle with vinegar to decontaminate the net after each sample site and
about 2 liters extra, depending on the number of sample sites.
D. Bring at least 2 liters of ethanol to preserve the collected samples. More, up to 1 or 2
gallons, may be necessary if it's a multi-day sampling trip.
E. Bring a wash bottle with DI water and about 2 liters of extra DI water.
F. Make sure the field sampling binder has enough Plankton Tow Data Sheets (Attachment
A), black permanent markers and pens, and a field thermometer.
G. Bring the handheld Hach meter, appropriate probes to measure pH, dissolved oxygen,

and conductivity, the GPS unit, and batteries.
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SOP 1.03: Plankton Sampling Technigues

.

Summary

Sampling shall be performed in such a manner as to minimize the amount of variation in the
data due to the technician performing the sampling. Record any environmental conditions
that may affect the test results or any departure from the procedures in the comments
section of the Plankton Tow Datasheet. The following field sampling procedures shall be
followed.

Equipment

Field sampling binder DI water

Plankton Tow Data Sheets DI water wash bottle
Plankton Tow Water Volume Sampled GPS unit & 4 AA batteries
Sheet Handheld Hach meter

Black permanent marker & pen Hach pH probe

Field thermometer Hach dissolved oxygen probe
Sample bottles (125ml, 250ml) Hach conductivity probe
Ethanol, 95% denatured with methyl & IPA Plankton net & cod-end
Ethanol wash bottle Line (marked every 1 meter) & reel
White distilled vinegar Boat

Vinegar spray bottle

Procedures

A. Locate the site to be sampled and bring the boat to rest. If boat continues to drift, tie off
to a structure if it is safe to do so. If there is no structure to tie off to, have one technician
operating the boat to keep it in place.

B. Record the Site ID, Date, Time, Location Description, Bottom Depth, and Depth of Tow on
the Plankton Tow Datasheet (Attachment A).

C. Hang a field thermometer from the boat so that the bulb of the thermometer is about 4
inches below the surface of the water. Read the water temperature after the field
thermometer has adjusted to the water temperature and record on the Plankton Tow
Datasheet.
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Record the GPS position during the field collection using the procedure described in SOP
2.01: Electronic Recording of Sample Sites Using GPS. Record the GPS coordinates on the
Plankton Tow Datasheet.

Record the dissolved oxygen, pH, and conductivity levels as described in SOP 1.16:
Measuring Dissolved Oxygen, pH, and Conductivity with the Hach Meter.

Record the turbidity using a Secchi disk, as described in SOP 1.17: Recording Turbidity
with the Secchi Disk.

Rinse net and cod-end in the lake before connecting cod-end to bottom of net.
Plankton samples are collected using the following procedure:
Label sample bottles as described in SOP 1.04: Sample Bottle Labeling.

Drop the net down to a maximum of 50 meters, or 3 meters above the bottom depth
if bottom depth is 50 meters or less. Hold line at desired depth until added tension
and weight is felt on the line before pulling the net up.

Manually retrieve net using a hand-over-hand technique at a constant rate of 0.5m/s.
Slow and steady retrieval is the key to collecting a good plankton tow.

After the top of the net has breached the surface, rinse the organisms into the cod-
end piece of the net. This is accomplished by lowering the net back into the water,
keeping the opening above the water surface, then quickly raising the net straight up.
This action will move the collected plankton into the cod-end. Repeat this procedure
several times to ensure all the organisms inside the net are in the cod-end.

Unscrew the cod-end and drain the water out through the mesh, leaving the plankton
behind. Using a gentle swirling motion can help speed up the process.

Using the DI water wash bottle, gently rinse the sides of the cod-end to condense the
plankton. After letting excess water drain out, pour plankton into labeled sample
bottle. Continue to rinse plankton into sample bottle until all plankton has been
transferred from the cod-end and into the sample bottle.

If the collected samples are especially dense and cannot be condensed to fit into a 125ml

sample bottle, use a labeled 250ml| sample bottle instead. If there are no 250ml sample

bottles available, use two 125ml bottles, and label appropriately “1 of 2” and “2 of 2.
Preserve samples as described in SOP 1.05: Plankton Sample Preservation.
Follow steps H-J to collect a replicate sample for PCR analysis.

Decontaminate net and cod-end with vinegar as described in SOP 1.06: Plankton Net
Decontamination.
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M. Record all remaining information on the Plankton Tow Datasheet. Refer to Plankton Tow

Water Volume Sampled (Attachment W) for the calculated amount in liters of lake water
sampled.
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: Attachments:
Plankton Sampling Site ID Key (C)
SOP 1.04: Plankton Sample Bottle Labeling

l.  Summary

A. Proper protocol must be followed when labeling bottles used for plankton sample
collection. These site identifications are used in conjunction with the date to form a
unique identification code to each sample received in the laboratory. It serves asan
identifier for all subsequent activities associated with each sample.

ll. Equipment

Sample bottles (125ml or 250ml)
Permanent black marker

ili. Procedures
A. Using a black permanent marker, each sample bottle will be labeled with:

Site Identification

Collection Date (format example: “28JUL14” ddMMMyy)
Depth of Tow

Preservation Technique

PwnNnPE

B. Refer to the Plankton Sampling Site ID Key (Attachment C) for routine, secondary,
random, and reported site names and identification codes.

C. Each Site ID will be followed by a number indicating the order in which the samples were
collected at a particular site. When replicate samples are taken, they will be designated
by capital letters in alphabetical order at the end of the Site ID (ex: WWM1A; WWM1B).
Samples that will be analyzed by microscopy will be labeled with an "A" and those for PCR
analysis will be labeled with a "B."
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Plankton Tow Datasheet (A)
SOP 1.05: Plankton Sample Preservation

I, Summary
To avoid degradation, samples need to be preserved in a 70% final ethanol solution.

II. Eguipment

Sample bottle
Black permanent marker
Ethanol, 95% denatured with methyl &IPA

I1l. Procedures

A. Immediately after collection, the sample is rinsed from the cod-end into a sample bottle
as described in SOP 1.03: Plankton Sampling Techniques.

B. Mark the level of sample with a permanent marker on the outside of the bottle.

C. Add three times the volume marked with ethanol. This will result in a nearly 70% ethanol
solution (66.67%).

D. Itisimportant that the amount of raw sample does not exceed 1/3 of the sample bottle
before the ethanol is added. At this amount, you would need to add enough ethanol to
fill the sample bottle completely.

E. If the sample is too large to be contained in a single sample bottle, it may be split into two
bottles. Make sure to record this on the Plankton Tow Datasheet (Attachment A) in the
comments section.

F. Record the preservative and the final solution percent (70% EtOH) on the Plankton Tow
Datasheet.
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Attachments:
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SOP 1.06: Plankton Net Decontamination

.

.

Summary

To prevent cross-contamination of plankton samples, the plankton net and cod-end need to
be decontaminated with vinegar between sample sites. If collecting a replicate at the same
site, decontamination does not need to be performed. Decontamination takes place after the
plankton sample has been rinsed from the cod-end into a sample bottle.

Equipment

Plankton net and cod-end
Spray bottle filled with distilled white vinegar

Procedures

A. With the cod-end disconnected, hold up the top of the plankton net and spray vinegar
liberally to the inside and outside black portion of the net.

B. Flip the net over and spray the inside and outside of the plastic at the end of the net
where the cod-end connects. Hold the net upside-down and spray the entire outer part of
the mesh until it is saturated with vinegar.

C. Finally, spray the inside and outside of the cod-end liberally.

D. Upon arriving at the next site, rinse the plankton net and cod-end separately and
thoroughly in the lake before collecting another sample.

E. Record the pre-sample net decontamination procedure on the Plankton Tow Datasheet
(Attachment A).

F. After each day of sampling is completed, each net and cod-end must be rinsed thoroughly

with water. This can be done either by hanging by the laboratory shower or with a hose
outside. Let plankton net hang to air dry.
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Attached Documentation:
Veliger Monitoring Laboratory Form (B)
Veliger Ostracod Comparison Chart (D)

SOP 1.07: Sample Processing by Compound Microscope

Summary

Procedures for processing a plankton sample with the Axiostar plus Zeiss Microscope are
described below.

Equipment

Piankton sample
63um sieve
250um sieve

Wash bottle filled with RO water
Spray bottle filled with white distilled
vinegar

Wash bottle filled with ethanol, 95%
denatured with methyl & IPA

Procedures

A.

Filter sample to remove larger particles.

1.

KimWipes

2 Petri dishes

Disposable graduated pipette

Glass beaker (at least 250ml)
Sedgewick-Rafter cell

Mechanical tally counter

Axiostar plus Zeiss Compound Microscope

Place a 250um sieve on top of a 63um sieve, aligning the rivets and rotating the sieves
so that the sample will not catch on the rivets.

Keeping the sieves together, pour the sample into the 250um sieve over the sink.

Rinse out the sample bottle at least three times to ensure that the entire sample is in

the sieve.

Gently run tap water over the sieves to allow any smaller organisms caught on the
larger sieve to pass through to the 63pum sieve.

Separate the sieves from one another. Using the RO wash bottle, condense all of the
particles on the 250um sieve to one side and rinse the plankton out of the sieve into a

beaker.
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Condense the smaller organisms on the 63um sieve using the RO water bottle and pour
into a Petri dish, using as little water as possible, as a fairly condensed sample is
preferred.

Complete the Site ID, Collection Date, Analysis Date, and Tech sections on the Veliger
Monitoring Laboratory Form (Attachment B). Indicate whether the sample was Filtered,
Split, the Split Method, and Number of Splits.

Clean the Sedgewick-Rafter cell with a KimWipe and place on microscope stage. The
sample is analyzed in successive 1ml aliquots taken by disposable pipette from the Petri
dish. Note : It is helpful to put a very small amount of liquid soap into the tip of the
pipette to help reduce the amount of sample that is left behind in the pipette.

Make sure the adjustable polarizing filter is in place and adjust the light settings so that
planktonic organisms are highlighted against a dark background.

Set the microscope to the 5x objective and the phase to H.

Scan the Sedgewick-Rafter slide by moving through the fields of each row and repeating
for all the rows to inspect the whole aliquot. Note : Repeat the same pattern for every
slide in every sample. "

Look for luminescent calcium carbonate shells that could be ostracods, Corbicula, or
Dreissenid veligers. Refer to the Veliger Ostracod Comparison Chart (Attachment D) and
the Zebra and Quagga Mussel Identification binder for classification.

To get a closer look at organisms, the 10x objective can be used. A magnification higher
than the 10x objective cannot be used with the Sedgewick Rafter cell. The organism of
interest will first have to be transferred to a microscope slide with a cover slip.

Tally each positively identified ostracod, veliger, or Corbicula onto the Veliger Monitoring
Laboratory Form as the sample is processed, as well as the number of slides analyzed.
Alternatively, the mechanical tally counter can be used to keep track of these items and
then transfer the final count onto the Veliger Monitoring Laboratory Form.

Take one photograph (under non-polarized light at 100X magnifications) of each
Dressenid veliger or unidentifiable organism with the AxioCam (refer to SOP 1.08:
Photomicroscopy Using AxioCam). For already known contaminated sample sites,
photographs are not needed.

After visually inspecting the whole slide, pour it into a glass beaker and rinse any residual
sample with the RO water bottle. Dry the slide with a KimWipe before adding the next
sample aliquot.

. Once processing in complete, fill out the rest of the Veliger Monitoring Laboratory Form.
If the sample was split, see SOP 1.14, Section IV. “Cheat Sheet.”

After bottling analyzed sample into glass vial, thoroughly spray the sieves, glassware, and
funnel with vinegar to decontaminate and let stand for at least 30 minutes before
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scrubbing clean with water. To clean the Sedgwick-Rafter cell, do not use vinegar as it will

quickly dissolve the adhesive under the gold frame. Wash the slide under running water
and gently scrub around the inside of the frame with a brush.
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Attached Documentation:
Veliger Monitoring Laboratory Form (B)
SOP 1.08: Photomicroscopy Using AxioCam

I.  Summary

Procedures for taking pictures of organisms using AxioVision software are described below.

II. Equipment
Axiostar plus Zeiss Microscope Computer with AxioVision software
Axiocam ERc5s Zeiss camera cable

IIl. Procedures

A. Turn on computer and connect the camera cable from the USB port on the left side of the
FlowCAM to the port on the back of the AxioCam (blue box) located on the top of the
microscope. *Note 1: On the top of the blue box, there is a small light that will be either
green or red. Wait until the light is green to connect the cable or the software will not
recognize the camera.

B. On the computer desktop, open the AxioVision Rel. 4.8 software.
C. Click the "Live" icon on the toolbar. The Live view window will open.

D. Pull.out the metal rod located on the right side of the microscope’s binocular tube to
switch the light path from the eyepiece to the camera and swivel the polarizing disk to the
left to remove from the field of view.

E. The Live view window should now show the sample with a slightly smaller field of view.

F. Make sure the magnification listed in the drop-down menu at the bottom left of the
screen is the same as the magnification of the objective.

G. To perform an automatic adjustment of image properties such as exposure and white
balance click on the associated buttons on the bottom toolbar. To enter in desired
settings click on the Properties button and go to the Display or Adjust property pages.

H. Focus on the object you want to photograph and click on "Snap”.

I. Close out of the Live view window and the image will be displayed.
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Select "Measure" from the toolbar, and then "Length"” from the menu. Click on one side
of the organism and then click on the opposite end to get the length. Again, make sure
the software is set to the same magnification as the objective so any measurements will
be displayed correctly.

Each image will be stored as a tab with a default filename. It is best to rename each photo
as it is taken to help keep track of the number of organisms-with the mechanical tally
counter.

Save images in a new folder labeled with the collection date followed by the Site ID. The
new folder should be located in the "Microscope Images" folder for the current year.
Save the images as JPEGs and rename the image files to reflect what was imaged and at
what magnification.

. Record the folder name containing the photos on the Veliger Monitoring Laboratory Form
(Attachment B).

Transfer image folders to the network drive. The destination folder is located at
U:\Aquatic\WaterLab\Water Lab - ZM Microscopy\Microscope\Veliger Sample Photos.
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SOP 1.09: Assembling FlowCAM Hardware

I, Summary

Procedures for setting up the hardware components of the FlowCAM are described below.

II. Eguipment
FlowCAM Mini funnel
4x objective Silicone tubing with collars
300FC or 300FOVS5 flow cell Short segment of silicone tubing
QCFC300 or QCFC SP flow cell holder Beaker (at least 250ml)
Collimator Disposable graduated pipette
Two polarizing filters Kimwipes

lll. Procedures

A. Install the microscope objective by threading it into the optics cube located on the left
side of the FlowCAM. When analyzing a plankton sample the 4x objective should be used.

B. Thread the collimator into place in front of the light source on the right side.

C. Make sure both polarizing filters are in place. One of the filters is located in the slot in
front of the camera on the left. The other one is positioned on the slide bar as close to the
collimator as possible.

D. Install the mini funnel holder into place above the objective.

E. Werap silicone tubing with collars around the peristaltic pump wheel while placing collars
in holders. Attach the short segment of outflow tubing to the collared tubing where the
OUT arrow is and feed it into a beaker.

F. Unscrew the retaining cap of the flow cell holder. Wipe flow cell with a Kimwipe and place
inside holder and replace cap. Tighten gently to avoid breaking the flow cell. The 300FC
flow cell goes in the QCFC300 flow cell holder. The 300FOV5 flow cell goes in the QCFC SP
flow cell holder. Both must be used with the 4x objective.

G. Install flow cell holder onto the mount in front of the 4x objective with the thumb screw
facing upwards and tighten.

H. Attach the inlet tube from the top of the flow cell to the funnel or pipette tip in the
holder. Next, attach the outlet tube from the bottom of the flow cell to the pump tubing
where the IN arrow is.
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SOP 1.10: Configuring VisualSpreadsheet 4X Software Program

I.  Summary

Procedures for configuring VisualSpreadsheet 4X to process plankton samples in cross-
polarized light are described below.

ll. Equipment

FlowCAM
VisualSpreadsheet 4X Version 2.4.1

ill. Procedures
A. Make sure the 4x objective is installed in the FlowCAM.
B. Double click and open the VisualSpreadsheet 4X icon located on the desktop.
C. Click Setup > Context...
D. Select the "Load" tab and click "Load a Context File..."

E. If using the 300FOV flow cell load the "Ax_XPL_Veliger_Settings_FOV_GLCA.ctx" context
file. If using the 300FC flow cell load the "Ax_XPL_Veliger_Settings_Standard_GLCA.ctx"
context file.

F. Select "OK" to close out of the Context window.
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SOP 1.11: Focusing the FlowCAM

Summary

Procedures for focusing the FlowCAM are described below.

Equipment

FlowCAM Filtered plankton Sample
VisualSpreadsheet 4X Version 2.4.1 DI water in wash bottle
Procedures

A. Add DI water to the pipette tip and disconnect the flow cell silicone tubing from the

tubing that wraps around the pump. This will cause the DI water to flow freely from the
pipette tip through the flow cell and prevent bubbles from forming in the flow cell
chamber. Reconnect the tubing when the DI water has passed through the glass
chamber.

If there are any remaining bubbles in the glass chamber, turn on the pump then pinch and
hold the tubing downstream of the flow cell for a few seconds and then release. This will
remove any air bubbles trapped within the flow cell.

In VisualSpreadsheet, go to "Setup" and select "Setup and Focus."

If using the 300FC flow cell, continue to Step E. If using the 300FOV (cuvette) flow cell,
use the horizontal thumbscrew to slightly adjust the position of the 300FOV flow cell so
that the two white lines defining the acceptable region are superimposed over the edges
of the flow cell.

Rotate the polarizing filter to raise the intensity mean to 100 so particles are easier to see.

Add a small amount of plankton sample to the pipette tip and turn the pump on
FORWARD and FAST.

As organisms begin to appear in the camera frame in the Setup and Focus window, switch
the pump to SLOW.

Focusing the FlowCAM on large stationary organisms yields the best results. By starting
and stopping the pump, it is possible to keep an organism in the frame.
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I.  Focus the image by turning the fine focus knob. Find the clearest focus on several
particles and then run the sample on SLOW and see how well particles are imaged.

J.  Once sufficiently focused, reverse the pump to bring all the particles used to focus back
into the pipette. Keep an eye on the cascading particles in the Setup and Focus window
to see if they are mostly in focus. If not, stop the pump and re-focus.

K. Rotate the polarizing filter to back down to lower the intensity mean to 25.
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Attachments:
Veliger Monitoring Laboratory Form (B)

SOP 1.12: Sample Processing by FliowCAM

1%

1.

Summary

Procedures for processing a plankton sample with the FlowCAM are described below.

Equipment

FlowCAM Dl water

VisualSpreadsheet 4X Version 2.4.1 250um sieve

Plankton sample 63um sieve

Mini funnel Disposable graduated pipette
Ethanol Vinegar

Procedures

A. On the Veliger Monitoring Laboratory Form (Attachment B), indicate the Analysis Date,

Tech, type of Flow Cell, whether the sample was split, Split Method, Number of Splits, and
the Photo Folder ID.

There should already be Di water and some sample in the mini funnel from focusing the
FlowCAM.

Go to "Analyze" and select "Autolmage Mode." Confirm that the "Stop only when user
terminates" box is checked and click OK.

The Save screen will open and prompt a filename. Name the file in the following format:
CollectionDate_4x_FlowCell_SitelD. Record the Folder ID on the Veliger Monitoring
Laboratory Form (Attachment B). Before pressing save, start the pump on FAST 5 (5
referring to the dial) and then press Save.

After the background has been calibrated, pipette sample from beaker into the pipette
tip/small funnel. Adding small amounts of sample at a time minimizes the chance of

clogging.

1. Ifa clog does occur, gently pinch and release the tubing below the flow cell until the
clog has broken up and passed through. This, however, may rotate the 300FOV flow
cell and cause the acceptable region lines and flow cell edges to misalign. The
software will then begin to image the edges of the flow cell repeatedly. To realign the
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flow cell, in the Autolmage window, go to "Tools" and then "Recalibrate." This should
prevent further imaging of the flow cell edges.

Adjust the intensity mean if necessary so that only birefringent particles are imaged (~25).
Continue adding sample at a steady rate.

When all the sample is in the pipette tip/small funnel, let the FlowCAM run until there is
only a little sample left in the tip.

Add DI water to rinse residual sample from the funnel and to help flush particles through
tubing and flow cell.

Watch the Autolmage screen for particles as water runs through the flow cell, adding
more water as needed, until nothing is being imaged.

As soon as the last of the sample passes through the flow cell and bubbles appear on the
screen, click “Pause” and record the FlowCAM run time (bottom left corner of the
Autolmage window) on the Veliger Monitoring Laboratory Form (Attachment B), and then
close the Autolmage window. This will end the run.

After the sample has run completely through the tubing, turn off the pump.

. Remove the pipette tip/small funnel and unhook silicone tubing from around the pump.
Attach a DI wash bottle to the top of the flow cell tubing and run DI water through it to
flush any remaining particles into the beaker.

Remove the remaining tubing and fill all tubing with vinegar and let stand for at least 1
hour before rinsing with DI water. Replace bigger plastic tube cover over the 300FC flow
cell to protect it. '

. After bottling analyzed sample into glass vial, thoroughly spray the sieves, glassware, and
funnel(s) with vinegar to decontaminate and let stand for at least 30 minutes before
scrubbing and rinsing clean with water.
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Attached Documentation:

Veliger Monitoring Laboratory Form (B)
SOP 1.13: Sample Post-Processing by VisualSpreadsheet

. Summary

Procedures for plankton sample post-processing with VisualSpreadsheet software are
described below.

lI. Equipment

FlowCAM
VisualSpreadsheet 4X Version 2.4.1
Mechanical tally counter

1l. Procedures

A. After completing the run, press "F3" to show all data and then "F2" to open the view
window.

B. Scan through all the collage images and click on those those that look like ostracods,
Dressenid veligers, or Corbicula. The frame around the image will turn red, indicating it is
selected. After all the images are selected, click the “Show Selected” button. Only the
selected images should now be displayed.

C. Go to "File" and select "Export Data." An Excel spreadsheet with the list of selected
images will open. Navigate to the column with the Source Image Number.

D. Open the current sample’s folder in Windows Explorer. From the Excel spreadsheet
Source Image Number Column, locate each image in the current sample’s folder and
copy, cut, and paste each one into the new temporary file.

E. In the temporary folder, review the raw images to verify that the image is of an ostracod,
veliger, or Corbicula. Delete the image if it is not. Use the mechanical tally counter as
images are identified.

F. After reviewing all the pertinent raw images, delete the rest of the raw images left in the
current sample’s folder. Make sure to keep all collage images.

G. Replace the selected raw images from the temporary folder back into the sample folder.

H. Empty the recycle bin.
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Record the number of raw images of ostracods, Corbicula, Dressenid veligers, and
unknown on the Veliger Monitoring Laboratory Form (Attachment B). If the sample was
split, please refer to SOP 1.14 Sample Splitting by Folsom and Motodo Sample Splitters,
Section IV. “Cheat Sheet.” *Note 1: Maximum number of splits is not limited to 5.

If there are images of suspicious or unknown organisms (besides images of poor quality
where identification is not possible), make copies of the raw image files and label the
images with the collection date and site ID.

1.

Open the copied image file in AxioVision to add a scale bar or measurements to the
image.

Go to "Measure" and select "Scalings." The Scalings Control window will open.
Choose "FlowCAM 4x" then click on "Apply selection to image." Close the Scalings
Control window.

Select "Measure" and then "Length." Click on one side of the organism and then click
on the opposite end to get the length.

Go to "File" and "Save As" to save the image as a JPEG.

Transfer any JPEG images of suspicious or unknown organisms to the network for
review by the Laboratory Director and/or Aquatic Ecologist. destination folder is
located at U:\Resources\Aquatic\WaterLab\VeligerSampling\FlowCAM\FlowCAM
Images.
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SOP 1.14: Sample Splitting by Folsom and Motodo Sample Splitters

l. Summary

Procedure for splitting plankton samples, after the sample is filtered, with 2 different
plankton splitters: Folsom Plankton Splitter and Motodo Plankton Splitter

Il Equipment

Folsom:; Motodo: Both:

Base/stand Base/stand RO water

Drum Splitter box Tap water

Peg Mild soap

2 boats Filtered sample

2 beakers (at least 250ml

Il. Procedures

A. Folsom

1. Assemble the drum, peg, and boats on the base.

2. Level the base by tightening/loosening the pegs in each corner of the base to place
the air bubble in the center of the circle in the level mounted on the base.

3. Pour the filtered sample into drum and rinse the beaker a minimum of three times.

4. Rotate the drum 120° back and forth several times to ensure thorough mixing of the
sample.

5. Rotate the drum to pour the sample into the boats and rinse the inside of the drum
while keeping it tilted so any remaining particles are flushed out. This complete one
split.

6. Keep track of the number of splits performed by making tally marks after each split
and record the number on the Veliger Monitoring Laboratory Form (Attachment B).
See table below for percentage of sample analyzed “Cheat Sheet.”
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7. To continue splitting, take one of the two boats and repeat steps 3-5 to complete as
many splits as needed to reduce sample to an acceptable size.

8. Hand-wash drum and boats with tap water and mild soap. Do not use any type of
alcohol for cleaning as the acrylic is not alcohol-resistant.

B. Motodo

1. Place the box with the groove fitted to the peg on the stand.

2. Ensure the base is level by tightening/loosening the pegs in each corner of the base
to place the air bubble in the center of the circle in the level mounted on the base.

3. Pour the filtered sample into box, washing beaker free of residual sample with RO
water. Slowly tilt the box back and forth several times, until sample is mixed. Leave
box tilted with the enclosed end resting on the base. Rinse residual sample with RO
water down into the resting end.

4. Pick up box and pour the half of the sample from the triangular hole in the corner of
the enclosed end into a large beaker. Be aware of the half of the sample on the
other side of the separating blade so it doesn’t overflow into the emptying
compartment when pouring.

5. While holding the box upright with triangular hole over beaker, squirt RO water into
box until all the residual sample has been washed down into the compartments.
This completes one split.

6. Keep track of the number of splits performed by making tally marks after each split
and record the number on the Veliger Monitoring Laboratory Form (Attachment B).
See table below for percentage of sample analyzed “Cheat Sheet.”

7. Repeat steps 3-5 to complete as many splits as needed to reduce sample to an
acceptable size.

8. Once finished with the splitter, hand-wash box with tap water and mild soap. Do not
use any type of alcohol for cleaning as the acrylic is not alcohol-resistant.

V. “Cheat Sheet”
# of Splits % of Sample Analyzed Multiply organism count by:

3
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SOP 1.15: Post-Processing Sample Preservation and Bofttle Labeling

Summary

Procedures for preserving a plankton sample post-processing and for labeling the sample
bottle.

Equipment

Fine point black permanent marker DIl water

30ml clear glass French square bottle Ethanol, 95% denatured with methyl & [PA
%” round white label Tap water

Square white label (about 1”x1”) Short-stemmed funnel

Processed plankton sample White distilled vinegar

63um sieve

Procedures

A. Pour the sample into the 63um sieve. Using tap water, rinse the beaker several times to

make sure no sample is left behind.

In the sieve, condense sample down to one corner and rid sample of any excess water.
Place the short-stemmed funnel in the glass bottle. Using ethanol, rinse the sample into
the bottle, leaving room at the top of the bottle to add enough DI water to make a final
70% ethanol solution.

Add DI water and cap bottle.

Place a %” round white label on the cap and a small square white label on the side of the
bottle.

On the cap, write the Site ID, collection date, and “>63um.”

On the side, write the Site ID; collection date; sample depth’ “70% EtOH”; “Analyzed” and
technician’s initials; the date the sample was analyzed; and “>63pum.”

Additionally, if more than one glass bottle was used, write on each label the individual
bottle’s number out of the total number of bottles used to store that sample (ex: 1 of 3).
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SOP 1.16: Hach Meter Use

Summary

Procedures for using the Hach meter to collect pH, conductivity, and dissolved oxygen in the
field, and equipment storage.

Equipment

Hach Multi-Parameter Meter, HQ40D

Hach IntelliCAL CDC401 Conductivity Probe

Hach IntelliCAL LDO101 Luminescent/Optical Dissolved Oxygen Probe
Hach IntelliCAL PHC101 Gel Filled pH Electrode

Hach pH Electrode Storage Solution

Procedures

A. Begin by plugging in up to two probes in the outer two ports on the top of the meter.
Align the pins and the notch, insert, and tighten the metal collar around the port.

i. The pH electrode has a translucent, plastic cap with a small, yellow sponge to hold
storage solution that will need to be removed each time it is used, and replaced
between uses to protect the small bulbs in the end of the electrode. Storage solution
does not need to be used in the short periods of time between sites, but should be
used if the electrode will not be in use for several hours (overnight, between a
morning sample and an evening sample, etc.).

B. Pressthe power button in the center, bottom of the face of the meter. The meter will go
through a quick startup process and will display the units of measurement of the
probe/electrode plugged in.

C. Lower the probe/electrode into the water until the entire metal piece of the
probe/electrode is submerged. Adjust the depth as needed for wave action so the
probe/electrode stays submerged.

D. To begin taking measurements, press the green button on the face of the meter. Above
this button on the screen says, “Read.”

E. The meter will begin taking measurements, and will display a progress bar for each probe
connected. When the meter stabilizes, the progress bar will be filled in gray, and when
the meter locks onto a measurement, the meter will sound a quiet beep, and will display
a small padlock symbol next to the measurement on the screen.
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F. To preserve battery life, turn off the meter between uses.

G. Before long-term storage, make sure the equipment is dry. This can be accomplished
either by hand drying or air drying.
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SOP 1.17: Secchi Disk Use

. Summary

Procedure for the use of a Secchi Disk, as a measurement of water turbidity. The quality of
Secchi depth data is user-dependent; it varies from person to person depending on vision. The
depth of visibility also depends on factors such as sunlight and wave action, which can both
produce extra glare on the water. It is encouraged to take several measurements and
measurements by multiple people for more precision.

iI. Eguipment

Secchi Disk
{ll. Procedures
A. Begin by locating the shaded side of the boat or dock.

B. With your back to the sun, lower the disk into the water off the shaded side of the boat or
dock until you can no longer see it.

C. Raise the disk until it is visible again, and lower it again until it's not visible. Repeat this
process until you are confident in the point at which you lose sight of the disk. Taking the

average of the depths at which it is visible and not visible can be an alternative option to
raising the disk and lowering it again.

D. Report the depth in meters, rounded to the nearest hundredth (##.## meters).
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SOP 2.01 Random Plankton Sampling Site Selection Using ArcMap

. Summary

Random sampling sites are generated based on current lake elevation using ArcMap software.
Map sheets showing random sample locations are created and printed for field documentation.

Il.  Equipment

Computer with network access
ESRI ArcMap 10
Color printer

I1l. Procedure

A. Start ArcMap software and open the random map template file:
Plankton_Random_yyyy.mxd , where yyyy is the current year.

1. The ArcMap — Getting Started window will appear after starting up ArcMap. On the left
side of the window under “Existing Maps,” choose “Browse for more” to open the map
template file in the Map Library for the current year:
U:\Aquatic\WaterLab\SpatiaI_Data\PIankton_Sampling_yyyy\Map__Library\
Plankton_Random_yyyy.mxd

B. Save the map as a new document so the template is not modified.
1. Click File > Save As.

2. Browse to the Map Library for the current year:
U:\Aquatic\WaterLab\SpatiaI_Data\PIankton_Sampling_yyyy\Map_Library\

3. Change the map name to: RZ_yyyymmdd_2Zxx_elev, where yyyymmdd is the current
date, xx is the random zone number, and elev is the current lake elevation rounded to

nearest 10 feet (for example: RZ_20110630_2Z01_3640). Click Save.

C. Make sure the “Spatial Analyst” extension is enabled. If not, the “Random Plankton Points”
tool will not function.
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1. Go to the ”Customlze” menu in the toolbar, click “Extensions...

File Edit Vew Bookmarks Insert Selection Qecpmcessing C indows ~ Help
CB@& « Bx or & ] Db e,
qafe in v on- o D .
Table OF Contents i A ensions
Qust

Select the ArcGIS Desitop
Style] extensions you want to use,
A Extensions provide extended

e
capabilities and usuglly require
that yeu have a ficense to use
them. The dialog fists the
extensions that are corrently
installed on your system and
which work with the application
you are currently using.

e

2. The Extensions window will open. Check mark the box next to “Spatial Analyst.” Close
the window.

Extensions

Select the extensions you want to use.

AreScan
Geostatistical Analyst
MNetwork Analyst
Publisher
Schematics

Spatial Analyst

[0 Trecking Analyst

goooooo

D. Generate random sampling points.

1. Click on “Random Plankton Points” located on the Random Sampling toolbar:
‘43 Random Plankton Points [ B Sy B N -

2. The “Random Plankton Points” window will appear.

Point Output Location 7
u: \Resources\Aquaﬁc\iﬁfcsterLab\.bpatai Data\Plankton Sampling_2011\GISSelected_SitesiRZ _yyyym'l' @
Lake Elevation {ft)
3620
Minimum Water Depth {ft)
93
Number of Samples o — —
8

Zone Raster

U iResources\Aquahc\kfv’atzerl.ab\Spahal Data\P!ankton sampling_2011\GISRandom_Sample_Selectior
Zone Polygon {optional)
TU \Resourcesifquatic\WaterLab\Spatial_Data\Plankton_Sampling_2 011M\GIS\Random, Samp»j []
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Verify the proper “Point Output Location” is listed for saving the shapefile:
U:\Aquatic\WaterLab\Spatial_Data\Plankton_Sampling_yyyy\GIS\Selected_Sites
where yyyy is the current year. Click the folder icon to browse to the appropriate
folder. Rename the shapefile in the format: RZ_yyyymmdd_2Zxx_elev.shp as previously
saved for the map file.

In the “Lake Elevation” box, type in the current lake elevation rounded to the nearest 10
feet.

In the “Minimum Water Depth” box, set the desired minimum tow depth. The
minimum water depth defaults to 98 feet or 30 meters. Note: For most zones the
minimum depth of 30 meters is sufficient. For inflow zones (Zones 8, 9, 13) the
minimum depth will need to be decreased.

In the “Number of Samples” box, set the number of points to be generated. Note: Not
all points generated have to be sampled. Generally 6 samples are collected on a given
trip so the number of samples to be generated should be at least 6.

Select the “Zone Raster” for the appropriate random zone to be sampled. Click the
folder icon to locate the desired file. The zone raster files are located at:
U:\Aquatic\WaterLab\Spatial_Data\PIankton_SampIing_yyyy\GlS\
Random_Sample__Se|ection\BaseIine\Random_PIankton_SampIing__Baseline_yyyy.gdb

Select the “Zone Polygon” for the appropriate random zone to be sampled. Click the
folder icon to locate the desired file. The polygon files are located at:
U:\Aquatic\WaterLab\SpatiaI_Data\PIankton_SampIing_yyyy\GIS\
Random_Sample_SeIection\BaseIine\Random_Plankton_Sampling__BaseIine_yyyy.gdb

Click OK. Random points are generated by the tool and the RZ_yyyymmdd_Zxx_elev
shapefile is added to the Table of Contents under “Index Map” in the Map data frame as
a new layer. Close the Random Plankton Points box when finished.

Right click on the newly created RZ_yyyymmdd_Zxx_elev shapefile and select “Zoom To
Layer” and the random points should be displayed.

Display the bathymetry layer for lake contours.

1.

In the Table of Contents, check the “bathy08_xxxx” layer where xxxx is the current lake
elevation rounded to the nearest 10 feet. Lake contour lines will be displayed.

Set symbology for the random sampling points.

1.

in the Table of Contents, double-click the newly created symbol, under
RZ_yyyymmdd_Z12_elev. The symbol selector window will open.
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Choose a symbol that is visible with the bathymetry layer. The suggested symbolis a
red “Circle 16” or red “Circle 17.” Click OK.

Update the map sheets text block in Layout View.

1.

2.

Click View > Layout View (if not already in layout view).

Double-click the text block in the lower left-hand corner of the map to open the
Properties dialog box. Note: The black arrow will need to be selected from the Tools
toolbar in order to change text.

Enter the Random Zone number, Lake Elevation (actual current lake elevation), and the
Shapefile and GPS Jobfile names. The shapefile is named as before:
RZ_yyyymmdd_2Zxx_elev.shp. The GPS jobfiles are named using the anticipated
sampling date, not the creation date in the following format: RZyymmdd. Click OK.

Prepare the document for printing.

1.

3.

Go to File > Page and Print Setup. Select the designated printer. Select “landscape” for
the orientation. (Note: The boxes for “Use Printer Paper Settings” and “Scale Map
Elements proportionally to changes in Page Size” may need to be checked to ensure
that the entire map is displayed on the printed page). Click OK.

Print the mapsheet. Go to File > Print, select Print.

Save the ArcMap document.

Export the set of map sheets (optional).

1.

Click File > Export Map.
Change “Save as type” to PDF.

Save PDF to the appropriate Map_Library using the current map name:
U:\Aquatic\WaterLab\SpatiaI_Data\PIankton_Sampling_wyy\Map_Library\

Close ArcMap when finished.
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SOP 2.02 Electronic Recdrding of Sample Sites using GPS

Summary
The location of all plankton samples collected will be recorded using the Thales

MobileMapper handheld GPS unit. GPS files and point locations will be labeled ina
standardized manner.

Equipment

Thales MobileMapper GPS unit
4 AA batteries

General Procedures for GPS Units

Each day of sampling will be given its own GPS job file. All GPS files should contain only
periods of time that are less than 24 hours. All points taken that day will be recorded in
the GPS and stored under that file, unless some samples are taken for special
circumstances and a separate file is justified.

GPS job files with selected random sample locations should be created and loaded on
the GPS prior to sampling to assist in navigation to random sites (refer to SOPs 2.01 and
2.04). Alternatively, map sheets or a laptop with a GPS can be used as a navigational aid
for random sites.

Prior to field use, ensure that a secure digital (SD) memory card and batteries are
properly installed in the unit, and that extra batteries are put in the GPS case.

. To turn on the unit, press the red “PWR” button once quickly, and press the “ENTER”

button three times in a row to cycle past the initial startup, copyright, and warning
screens.

To turn off the unit, press red “PWR” button once, and the unit will shut off at the end
of a 5-second countdown. Note: if the GPS unit is turned off, the active job file is closed

and will need to be reopened to save new points.

Pressing and holding the “PWR” button will adjust the backlight settings.

. The “NAV” button cycles the GPS display between the map, compass, position, and

satellite status screens.
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The map screen shows current position and heading with a triangle. The center scrolling
button can be used to move a cursor around the screen for selecting features. Press
“ESC” to hide the cursor and return to the current position marker. Pressing the “IN”
and “OUT” buttons will adjust the level of zoom displayed on the map screen. Note: the
position cursor will display as an hourglass if the unit has not established adequate
satellite connections.

The compass screen shows speed, distance, and direction to a waypoint.

The position screen can be used to manually record the current GPS position in NAD83
UTM format (xxxoxxxxE xoooxxN), and also displays the current time and date.

The satellite status screen shows how many satellites the GPS unit has established
connections with, and the strength of the satellite signals (shown as black bars). An
accurate position fix cannot be determined unless the unit has connected to at least 3
satellites. This screen also shows remaining battery power.

The “MENU” button is used to create or open GPS job files that sample point locations
are saved into.

_ The “LOG” button is used to create a new point location in the open job file.

Pressing “ENTER” will accept the highlighted selection.
The “ESC” button will take you back to the previous screen without making any changes.

GPS Job File Naming Conventions

A. Plankton Sampling job files created in the field for routine sample collection are given a

7_character name which has a prefix to designate the sample type (Z for zebra mussel)
followed by the current date in yymmdd format (Zyymmdd). Example: locations of
plankton samples collected on 21AUG10 would be saved in a job file named “Z100821.”
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Selected site job files created prior to random sampling and uploaded to the GPS unit
for navigation are given a “RZ” prefix (for random zebra) followed by the anticipated
sampling date in yymmdd format (RZyymmdd). Example: A random sampling map is
prepared on 07AUG10 for sampling on 14AUG10. The selected points will be uploaded
to the GPS in a job file named “RZ100814.”

If the job file in use becomes corrupted and new points cannot be recorded in it, a new
job file is created with the “Z” prefix, the current date in yymmdd format, and an
additional 1-letter suffix starting with “A” (Example: job file “RZ2100814” becomes
corrupted while sampling. A new file named “Z100814A” is created and used for
subsequent points).

Creating and Opening GPS Job Files

Turn on GPS unit and wait for the GPS to establish a satellite connection.

To create a new GPS job file, press the “MENU” button, then highlight and select “New
Job.” Enter the job name by using the scrolling center button to move around the
alphanumeric display, and the “ENTER” button to register each character. When the
entire name has been entered, highlight “Ok” and press “ENTER.”

On the feature library screen, highlight “ZM_SAMPL.MMF” and press “ENTER.” The
“ZM_SAMPL” template contains the attribute fields necessary for recording plankton
sample data associated with each location (SitelD and ColiDate).

On the job mode screen, highlight “Post-processing” and press “ENTER.” Selecting
“Post-processing” allows the points collected in the field to be differentially corrected
on a computer to improve their accuracy.

Press “NAV” to return to the map screen.

To open an existing or uploaded GPS job file, press the “Menu” button, then highlight
and select “Open Job.” Highlight the desired job file on the job list screen and press
“ENTER”.

Recording Point Features at Sample Sites

If the GPS unit is not on, power it up and wait for the GPS to establish a satellite
connection.

If the correct job file is not active, create or open an existing GPS job file, as
appropriate.

To record the sample site location, press the “LOG” button to bring up the new feature

screen. The feature type will be “ZM_Sample” for jobs created on the GPS, and
“RZ_yyyymmdd_Zxx_elev” for uploaded random sampling jobs.
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Press “ENTER” on the new feature screen to log the sample site location. The GPS
display will show the logging screen and the unit will start recording positional data. To
stop collecting point data, highlight the “Close” icon on the logging screen and press
“ENTER.” Log points for 15 seconds.

Editing Feature Attributes

After recording a sample location, press “ESC” or “NAV” as necessary to return to the
map screen.

Move the cursor on the map screen directly over the new point feature with the
scrolling center button. When the feature has been highlighted, the feature name
(“ZM_Sample” or “RZ_yyyymmdd_Zxx_elev”) will be displayed at the bottom of the
screen. Press “Enter” to open the selected feature screen for that point.

The selected feature screen will show the feature attributes (SitelD and CollDate) and
their values. If you are entering data for new point, these attributes should be blank. If
they are not blank, press “ESC” to return to the map screen and select the correct
point. The “IN” and “OUT” buttons can be used to adjust the zoom to an appropriate
level for selecting the correct feature.

To enter or edit feature attribute values for the selected feature, highlight the “Edit”
icon and press “ENTER.” Highlight the SitelD attribute and press “Enter” to bring up
the alphanumeric display. Type in the SitelD then highlight the “OK” icon and press
“ENTER” when finished to return to the selected feature screen. Highlight the CollDate
attribute and repeat the process to enter the current date in the appropriate format
(e.g. 14AUG10).

After editing both the SitelD and the CollDate fields, highlight the “Close” icon on the
selected feature screen and press “ENTER.”

If a point feature is accidentally created at a location where no sample is taken, the
SitelD should be set to “NOSAMPLE” or “NONE.”

Changing the GPS Background Map Display

To select a background map, press the “Menu” button, then highlight and select
“Setup.”

On the setup menu screen, highlight “Select Map” and press “ENTER.”
On the change map screen, highlight the desired detail map or select “Empty” to use
only the default background map. Detail map names reflect the lake elevation

contours used to create their symbology. (e.g. WQ3640.IMG shows the shoreline at
3640 feet and should be selected for lake elevations close to 3640 feet).
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After selecting a detail map, highlight “Save” and press “ENTER.” The detail map will
now display on the map screen. v

Additional detail maps can be created in MobileMapper Office and uploaded to tﬁe
GPS as Disc Image files. '

R
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SOP 2.03 Downloading and Differentially Correcting GPS Points

Summary

Raw sample site data recorded in the field are downloaded from the GPS using
MobileMapper Office. GPS points are then differentially corrected to improve accuracy.
Copies of the raw and corrected GPS data are stored in folders specific to the GPS unit,
and a shapefile is exported for GIS analysis.

Equipment
Thales MobileMapper GPS Unit MobileMapper Office
Computer with network access ArcCatalog 10

Secure digital (SD) card reader

Downloading Raw GPS Data to the Network

Remove the secure digital (SD) memory card from the Thales MobileMapper handheld
unit. The card is located in the battery compartment.

Connect card reader to the computer and insert the GPS card.

In Windows Explorer, transfer all the files associated with a given date from the GPS
card to the appropriate raw GPS data folder location on the network.

Raw data from the Wahweap GPS unit is stored at:
U:\Resources\Aquatic\WaterLab\SpatiaI_Data\Plankton_SampIing_yyyy\GPS\WW_U
nit\Raw

where yyyy is the current year.

Raw data from the Bullfrog GPS unit is stored at:
U:\Resources\Aquatic\WaterLab\SpatiaI__Data\PIankton__Sampling_yyyy\GPS\BF_Uni
t\Raw

Highlight the MobileMapper job file ((MMJ) and all associated files (.R00, .M0O, .GOO,
etc.) then right-click and choose "Copy." Go to the folder location for the Bullfrog or

Wahweap GPS unit, then right-click and choose "Paste.”

Transferring Raw GPS Data to Corrected Data Folder
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MobileMapper Office must be used to transfer the raw data to the corrected data
folder. Raw data copied from the SD card using Windows explorer will not be properly
formatted for differential correction.

Start MobileMapper Office.

Select “File” from the menu bar and select “Download from GPS." The MobileMapper
Transfer window will appear.

Set the left (source) and right (destination) MobileMapper Transfer windows to the
appropriate directories.

Source directories for Wahweap and Bullfrog units (respectively) are:
U:\Resources\Aquatic\WaterLab\Spatial_Data\Plankton_Sampling_yyyy\GPS\WW_U
nit\Raw
U:\Resources\Aquatic\WaterLab\Spatial_Data\Plankton_Sampling_yyyy\GPS\BF_Uni
t\Raw

Destination directories for Wahweap and Bullfrog units (respectively) are:
U:\Resources\Aquatic\WaterLab\Spatial_Data\Plankton_Sampling_yyyy\GPS\WW_U
nit\Corrected
U:\Resources\Aquatic\WaterLab\Spatial_Data\PIankton__Sampling_yyyy\GPS\BF__Uni
t\Corrected

Choose “File” from the menu bar and click on “Connect” then “PC Drive.” Navigate to
the appropriate directories if they are not displayed in the left and right windows.

Click and drag the selected MobileMapper job file from the left window to the right
window. The “Copying File” window will appear. In order to transfer more than one file
at a time, hold down the “Ctrl” key on the keyboard while selecting.

[52 U= v] [0 ABeach_Moritoring_2010\GPS\BF. Unit\Comrec
Name / Text | Size | Modified

e, -~ UP-DIR 12/7/2010 04: 1€3., ->UP-DIR* 12/7/2010 14,

149 01jun1o mmj 699,497 6/1/201010:2 | CIRINEX *SUB-DIR” 12/7/2010 10z

£ bm100531 mmj 2,790,374 6/1/2010 14:4 [B01junl0 mmj 1,022,760 6/1/2010 17:2
HOLIUNLO_COR mmj 2213 12/7/2010 108
B bm100531 mmj 4,140,957 5/31/2010 18:
GPBMI0053L COR  mmj 17457 12/7/2010 10z
] download log 0 12/7/2010 14

source (“Raw” folder) —————p destination (“Corrected” folder)
When the transfer is finished, close the MobileMapper Transfer window. The file(s)

transferred will be displayed in the MobileMapper Office window.

Differentially Correcting GPS Data
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Wait at least 24 hours after completion of sampling before differentially correcting a
file.

Start MobileMapper Office and open the GPS job file to be differentially corrected.
Select “File” from the menu, then “Open” from the drop down list. Navigate to and
select the job file from the appropriate “Corrected” data folder. The file will now be
displayed in the MobileMapper Office window.

Before differentially correcting the job file, resave it as “filename_COR.mmj” in the
“Corrected” folder. Select “File” from the menu, then “Save As” from the drop down
list.

Download reference station data for the open job file. Click on the "Download
Reference Station” button found on the lower toolbar.

]

A S Al

FieName | SttTine ] EndTime Tine B
= "O1JUN10 67172010 10:10:50 AM 6/172010 10:26:324M B

= " OUUNTO 6/1/2010 11:16:32 AM 67172010 12:04:55 PM

The “RINEX Download” window will appear. Set Provider, Station, and Time Zone as
shown below. The start time and end time should be adjusted to completely encompass
the time when points were logged (if necessary).

Provider :

Station : }FHED ::_3 Lasscd e
Time Zone : |(UTC-07:00) Arizona |
Start Date: | 6/ 1/2010 ~]  StatTime: [10:05:30 AM -
Duration: |02:05 =
EndDate: | 6/ 12010 ~]  EndTime: [12:10:00 Pi e

Target Path: §U:\Flesources‘\.ﬁquakic\WaterLab\SpatiaI_Data\Beach_Monikoring_jU _J

Provider Infos ©  hitp/Aaww ngs noaa.qov/CORS/ Download g Close i 1

Target Paths for Wahweap and Bullfrog units (respectively) are:
U:\Resources\Aquatic\WaterLab\SpatiaI_Data\Plankton__SampIing__yyyy\GPS\WW_U
nit\Corrected
U:\Resources\Aquatic\WaterLab\SpatiaI__Data\PIankton__Sampling_ywy\GPS\BF_Uni
t\Corrected
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Click “Download” and then click “Close” when the download is complete.

In the box on the bottom of the MobileMapper Office window, a yellow bar will appear
beneath the green bars of the GPS file. Make sure this yellow bar extends beyond both
ends of the all the green bars. If not, download additional RINEX files to cover the
missing time periods.

> " DIJUN10 8/1/2010 10:10.50 AM 67172010 10:26:32AM |
- “O1JUN10 6/1/2010 11:18:32AM 6/1/2010 12:04:55 PM
A BFREDA10.152 6/1/2010 10:085:30 AM 6/1/2010 1210:30PM |

[FleName | StatTime End Tine ! Time Bar o - i

Set the coordinate system for the job. Select “Options” from the Menu bar. Click
“select Coordinate System.” The “Select Coordinate System” window will appear.
Select "NAD1983_UTM_Zone12N" from the drop-down list. The coordinate system will
then be displayed in the lower right hand corner of the screen.

Note: If this coordinate system does not appear in the drop-down list, it can be
added by importing any shapefile that uses the NAD1983_UTM_Zone12N projection
into MobileMapper Office. Click File>Import to open the shapefile and the
projection will become available. Once the projection has been added, reopen the
“filename_COR.mmj” to finish differential correction.

Differentially correct the data. Click on the “Process data” icon, and then click "Okay"
when processing is complete.

1 : : .

AR A S FE]

FleNeme i StatTime [ EndTime . _ .

2 "O1UNTO 8172010 10:10:50AM  6/1/2010 10:26:32 AM

2 " OUUNTO 6/172010 11:16:32AM  6/1/2010 12:0455 PM

"% BFREDAIOA52  6/1/2010 10:05:30AM  6/1/2010 1210:30PM [

The “Correction” field in the Job Properties box should change from “Real-time” to
“Post-processed” to indicate that the correction has been applied.

1 Job Properties “{ Job Properties
Property | Value ‘ Property [ Value |
Job Nams T1JUN1D Job Mame 01JUNTO_COR
Receiver MobileMapper 6.56 Receiver MobileMapper §.56
sin 00C017255655 50 00617255655
Start Time 67172010 10:11:31 AM Start Time 6/1/2010 10:11:31 AM
End Time 6/172010 11:51:35 AM End Time 6/1/2010 11:51:35 AM
Duration {hh:mm:ss} 01:40:04 Duration {th:mm:ss}) 01:40:04
Correction Realtime orreTion P Post-processed
Number of Features 4 Mumber of Festures 4
Features per Feature Type Features per Feature Type
& WQ_Sample & 4 WQ_Sample 4
Save the job file.
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Exporting Corrected GPS Data

Export the corrected points to a shapefile for GIS analysis. In MobileMapper Office,
choose "File" from the menu bar and click "Export...".

Export directories for Wahweap and Bullfrog units (respectively) are:
U:\Resources\Aquatic\WaterLab\Spatial_Data\Plankton_Sampling_yyyy\GPS\WW_U
nit\Export
U:\Resources\Aquatic\WaterLab\Spatial_Data\Plankton_Sampling_yyyy\GPS\BF_Uni
t\Export

Click “Export.”
Rename the exported shapefile to match the job file it originated from in RZyymmdd or
Zyymmdd format. Start ArcCatalog and locate the exported shapefile. Job files created

on the GPS unit will default to “ZM_Sample” and random sample jobs uploaded to the
GPS will default to “RZ_yyyymmdd_Zxx_elev.” Select the file and press F2 to rename it.
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SOP 2.04 Uploading Random Sample Points to GPS

l. Summary

Random sample site shapefiles created in ArcMap are converted to GPS job files. Job files
are then uploaded to a Thales MobileMapper GPS unit to assist with field navigation.

. Equipment
Thales MobileMapper Handheld GPS MobileMapper Office software
Unit SD memory card from GPS
Computer with network access SD card reader

1. Procedure for Uploading Random Sample Point to GPS

A. Start MobileMapper Office.
B. Click File > Import.

C. Navigate to the selected shapefile to be uploaded and click Open. Random sample
shapefiles are stored at:
U:\Resources\Aquatic\WaterLab\SpatiaI_Data\PIankton__SampIing_yyyy\GIS\SeIected_Sites
where yyyy is the current year.

D. Click Import in the Import GIS Data window to add the point features.

E. Save the point features in a GPS job file. Go to File > Save As.

F. Navigate to the Uploads folder for the Wahweap or Bullfrog GPS Unit. The Uploads folder is
located at:
U:\Resources\Aquatic\WaterLab\SpatiaI_Data\Plankton_Sampling_yyyy\GPS\WW_~Unit
for Wahweap or \BF_Unit for Bullfrog.

G. Name the GPS job file in the format: RZyymmdd where yy is the 2-digit year, mm is the 2-
digit month, and dd is the 2-digit day. Then click Save.

H. Proceed to Section IV if uploading using a thin client computer and a SD memory card

reader. Proceed to Section V if uploading using a computer with a serial port and
MobileMapper Office.
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Upload Using a Thin Client and SD Card Reader

Remove the SD memory card from the GPS battery compartmeht.

Connect the SD card reader to the computer USB port and insert the SD memory card from
the GPS into the reader.

In Windows Explorer navigate to the Uploads folder and right-click on the desired GPS job
file and choose Copy.

In Windows Explorer open the drive associated with the GPS memory card. Right-click
within the GPS memory card window and choose Paste to transfer the desired GPS job file
to the GPS memory card.

Upload Using a Computer Serial Port Cable and MobileMapper Office

Connect the GPS unit to the computer with the serial port communication cable.
Press “PWR” to turn the GPS unit on.
in MobileMapper Office, click File > Upload to GPS > Job.

The “Uploading to GPS” window will open while MobileMapper Office connects to the GPS
and uploads the file. The window will close automatically once the upload is complete.

Press “PWR” to turn the GPS unit off.

Disconnect the GPS unit from the computer.
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SOP 2.05: GIS Data Management

Summary

Plankton sample shapefiles exported from MobileMapper Office are copied into the GIS
directory and organized by sampling date. Shapefiles are projected and edited to ensure
attribute data is correct and all points are accounted for. Edited shapefiles are appended
to a geodatabase, and the locations of missing points are estimated. GIS data is then
loaded into the GLCA Plankton Samples geodatabase and is joined with tabular laboratory
data stored in an Access database.

Equipment
Computer with network access Microsoft Access
ESRI ArcGIS 10.x Plankton sampling datasheets

Procedure for Editing GIS Points

Follow these steps to copy shapefiles from the GPS export directory and organize by
sample date.

1. Start ArcCatalog and browse to the WaterLab\Spatial_Data directory.

2. In the Plankton_Sampling _yyyy\GIS\Sampled_Sites folder for each laboratory,
create a new folder named \yyyymmdd for each day that water samples were
processed in that lab.

3. Create a new \edited subfolder in each of the new sample date folders.

4. Reference the original field data sheets to determine which GPS jobfile(s) were used
to collect GPS points for each sample date.

5. Locate the shapefiles exported from those GPS jobfile(s) in the
\GPS\WW_Unit\Export or \GPS\BF_Unit\Export directory.

6. Copy and paste the shapefiles from the GPS export directory into the GIS sample date
(\yyyymmdd) folder for the correct laboratory.

B. Project all shapefiles in the sample date folders, and copy to the \edited subfolder.
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Click Windows > Search to open the search &

window in ArcCatalog.

Type Project and press Return.

Click Project (Data Management) to open the %, Define Projection (Data Management)

projection tool.

SOP 2.05 Issue 1

Local Seércﬁ

ALL  Mips  Dat Tesls L=
[project] O {;:_} "
Help i :

&
X
yoreas i |

iy 40X

Search mtumed 10 items,

* This tool averwrites the coordinate system.. | |
toclboxeshsystem toalboxes\data manage...

& Projections and Transformations
Surnmary: not available,
toolboxeshsystern toolboxes\data Manage..,

%, Project (Data Management)
Crcates a new dataset or featur it
renlbnxesisystern tonlboxesidata Qe i

mo -

Drag a shapefile from the sample date folder to Input Dataset.

An Output Dataset name is automatically assigned (filename_Project.shp).

Set the Output Coordinate System to NAD_1983_UTM_Zone_12N.

a. Select...> Projected Coordinate System > UTM > NAD 1983

b. Click Add > Ok.

Click Ok to create a new
projected file.

o iy Project’ -

Input Dataset or Feature Class
Uy \Resources\Aquatlc\WaterLab‘gSpat|a| Data\Beach Monltorlng_znlD\GlS\Samplsd Ste:

Input Coord inate System (opt )

RAG_ 1959 UM o T
Output Dataset or Feature Class e
us \Resources\Aquat!:\WaterLab\SpatlaI Data\Beach Monﬂ:oﬂng_ZOlD\GlS\Sampled SIte@
Output Coordinate System

NAD_ 1983 UTM Zone, 12N
Geographic Transformation (OPHONEI. . . ......c.oo. e o enns oo oo scemrrains s o it

Copy and paste the projected file filename_Project.shp from the sample date folder
\yyyymmdd to the edited subfolder \yyyymmdd\edited.

Repeat if necessary for additional shapefiles in the sample date folder.

C. To project and copy many files concurrently, use the Project and Copy model builder tool.

In ArcCatalog, locate the Project and Copy tool in the
PlanktonSamplingDBToolbox.thx at:
U:\Resources\Aquatic\WaterLab\SpatiaI_Data\Plankton__SampIing_yyyy\GlS\
Random_Sample_Selection\Tools\

Right-click Project and Copy>Edit to open the Model Builder interface.

Double-click Iterate Feature Classes.
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4. Setthe Workspace or Feature Dataset to the folder that you want to process

(Plankton_Sampling_yyyy\GIS\Sampled_Sites\WW or BF). All shapefiles in the folder
you select will be projected and then copied to the same directory they are currently
in.

Check “Recursive” to process shapefiles in all subfolders of the designated
Workspace. This option allows the tool to project and copy files in sample date
subfolders of Plankton_Sampling_yyyy\GIS\Sampled_Sites\WW or BF. Click “OK.”

o~

%, lterate Feature Classes

Workspace or Feature Dataset Itel
eF R Clz
wildeard {optional)
lter:
Feature Type {optionall B clag
- Fea
[7] Recursive foptional)

On the ModelBuilder toolbar, click Model>Run Entire Model.

When the Project and Copy tool has finished running, use ArcCatalog to move the
copied files filename_Project_Copy.shp from the sample date folder \yyyymmdd to
the edited subfolder \yyyymmdd\edited.

D. Merge shapefiles for sample dates with multiple files in the \edited folder.

1.

Click Windows > Search to open the search window in ArcCatalog.
Type Merge and press Return.
Click Merge (Data Management) to open the merge tool.

Drag all files in the \edited folder to the Input Datasets textbox. The filenames will
appear in the Datasets list.

The Output Dataset name will default to filename_Merge.shp.
Press Ok to run the merge tool.

in ArcCatalog, delete all files from the \edited folder except for filename_Merge.shp.
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Edit point features to remove extra points and correct attributes.

1.

10.

11

Start ArcMap and press “Cancel” to work in an empty map.
Click Customize > Toolbars and verify that the Editing toolbar is checked.

Click ¥ Add Data to add the shapefile to be edited from the sample date edited folder
(filename_Copy.shp, filename_Merge.shp or similar).

Click Editor > Start Editing on the Editing toolbar.
In the Table of Contents, right-click the shapefile and click “Open Attribute Table.”

Compare the features listed in the table to the original field data sheet for the sample
date.

Delete any features that don’t represent an actual sample location, such as selected
sites, or technician GPS errors.

a. Click the small box left of the feature FID to highlight the feature.
b. Press “Delete.”
Correct technician entry errors in the formatting of the SitelD and CollDate fields. All
characters in these fields should be uppercase with no spaces allowed. CollDate
follows the ddmmmyy format where mmm is the 3-character alphanumeric
abbreviation.

a. Double-click in the field that is incorrect to bring up a cursor.

b. Correct the error.
Annotate any missing GIS points on the field data sheet. If data entry has already
been completed, the Access database and printouts should also be annotated

following the relevant SOPs.

Save edits made to the template shapefile. Click Editor > Stop Editing > Yes on the
Editing toolbar.

in ArcCatalog, rename the completed shapefile ZM_yyyymmdd_BF.shp or
ZM_yyyymmdd_BF.shp.

Procedure for Appending Edited GIS Points to Geodatabase

To append edited GIS shapefiles to the geodatabase, use the Append to DB model builder
tool.
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In ArcCatalog, locate the tool in the PlanktonSamplingDBToolbox.tbx at:
U:\Resources\Aquatic\WaterLab\Spatial_Data\Plankton_Sampling_yyyy\GIS\
Random_Sample_Selection\Tools\

Right-click Append to DB > Edit to open the Model Builder interface.
Double-click the Append box.

Input Datasets can be remain blank.

Set the Target Dataset that files will be appended to by navigating to the desired
folder. Choose ZM_All_Sites_yyyy_BF or ZM_All_Sites_yyyy_WW as appropriate
from: U:\Resources\Aquatic\WaterLab\SpatiaI_Data\Plankton_SampIing_yyyy\GIS\
Sampled_Sites\All_Sites\ZM_All_Sites_yyyy.gdb. Click OK once the Target Dataset
has been selected.

Append
Input Datasets R :L :
I A=)

&% FeatureClass E
ainl
a4

Target Dataset
w:'\Resources\Aquatic\\"iaterl_ab\SpatiaI_Data‘&lank’con_ﬁampling_2011\GIS\Sampled_Sites\ __‘j @
Schema Type (optionall . .

TEST v

Field Map {optional}

| T

f oK. 3 [ Cancel J [ Apply ) 1 Show Help > ]

Double-click Iterate Feature Classes.

7. Set the Workspace or Feature Dataset to the folder that you want to append files

from (\Plankton_Sampling _yyyy\GIS\Sampled_Sites\WW or BF).
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8. Check “Recursive” to process shapefiles in all subfolders of the designated
Workspace. This option allows the tool to append files in sample date\edited
subfolders of \Plankton_Sampling _yyyy\GIS\Sampled_Sites\WW or BF.

9. Set the Wildcard to “ZM*” to ensure that only shapefiles that have been edited and
renamed will be appended to the database. Click OK.

#

Workspace or Feature Dataset
}Resources\Aquatic\WaterLab\Spatial_Data\PlanktDn_Sampling,Zﬂll\GIS‘\Sampled_Sites\Bﬂ __ﬂ E@

Wildcard {optionaly
ZM*
Feature Type (OPHOMAI e

[Z] Recursive {optional}

10. On the ModelBuilder toolbar, click File > Run Entire Model.

Procedure for Estimating Missing GIS Points

A. Point estimates of sampling site locations not recorded with a GPS unit can be saved in
the ZM_All_Sites_yyyy_estimated feature class located at:
U:\Resources\Aquatic\WaterLab\SpatiaI_Data\PIankton__SampIing_yyyy\GIS\
SampIed_Sites\AlI_Sites\ZM_AlI_Sites_yyyy.gdb

B. Annotate estimated GIS points added to the database on the field data sheet. If data
entry has already been completed, the Access database and printouts should also be
annotated following the relevant SOPs.

C. Selected site locations can be used as random sampled site estimates.

1. Determine which selected site location was used for the random site from the field
data sheets and maps.

2. In ArcMap, open the appropriate selected site shapefile and estimated feature class.

3. Click Editor > Start Editing on the Editing toolbar, and select the
ZM_AIl_Sites_yyyy_estimated feature class.
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Select the Edit tool from the Editing toolbar, and click on the selected site point
feature corresponding to the missing random point.

In the Table of Contents, right-click the selected site shapefile and click “Open
Attribute Table”. Verify that the correct point is highlighted.

Right-click the selected site shapefile and select Copy.

Right-click the selected site shapefile and select Paste. Choose
ZM_AIl_Sites_yyyy_estimated as the layer to paste into.

Open the attribute table for the estimated layer and modify the SitelD and CollDate
fields to the correct values.

Click Editor > Stop Editing > Yes on the Editing toolbar to stop editing and save edits.

Routine site locations can be estimated based on previous sampling locations or from the
description of the site location.

1.

6.

In ArcMap, open the estimated feature class and add any necessary reference layers.

Click Editor > Start Editing on the Editing toolbar, and select the
ZM_AIl_Sites_yyyy_estimated feature class.

Select the Create Features tool from the Editing toolbar, and select the Point

57 Poi . .
2+ Point onstruction tool from the Create Features window.
Click at the desired location on the map to create a new point.

Open the attribute table for the estimated layer and modify the SitelD and ProcDate
fields to the correct values.

Click Editor > Stop Editing > Yes on the Editing toolbar to stop editing and save edits.

Procedure for Updating the GLCA Plankton Sampling Geodatabase

The GLCA_Plankton_Samples geodatabase is loaded with new data after all recorded and
estimated points have been edited and appended to the ZM_All_Sites_yyyy geodatabase.

In ArcCatalog, navigate to the GLCA_Plankton_Samples geodatabase located at:
U:\Resources\Aquatic\WaterLab\Spatial_Data.

Right-click the GLCA_Plankton_Samples_2008_present feature class and select
Load>Load Data.
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3. Inthe Input Data box, navigate to and select the ZM_All_Sites_yyyy_BF feature class.
Press Open and then Add to add the file to the list of source data to load. Add the
ZM_AIl_Sites_yyyy_WW and ZM_All_Sites_yyyy_estimated feature classes to the
list.

4. Click Next to advance to the summary page, and then click Finish to load the data.

B. Calculating the GPS_ID field for joining tabular data.

1. Open ArcMap and add the GLCA_Plankton_Samples_2008_present geodatabase
feature class to the layer.

2. Open the attribute table of the geodatabase.
3. Highlight all points added for the current year.
4. Right-click the GPS_ID field header and select “Field Calculator.”

5. Inthe “GPS_ID =" window add the following equation string:
[CollDate] &"-"& [SitelD]. Then click “OK.”
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Attached Documentation:
Veliger Monitoring Laboratory Form (B)

SOP 3.01: Internal Audit for Precision

.

Summary

At the beginning of every summer sampling season and every month thereafter, the Quality
Assurance (QA) Officer performs an internal audit to test the precision between technicians in
the analysis of plankton samples for Dreissenid veliger detection and enumeration. An
internal audit must be performed by all technicians for both microscope and FlowCAM
techniques.

Equipment

Axiostar plus Zeiss Compound Microscope

FlowCAM

Two previously analyzed plankton samples with veligers

Plankton sample processing and analysis equipment (Refer to SOPs 1.07-1.13)

Procedures
A. The QA Officer chooses a previously analyzed sample with a known number of veligers.

B. Technicians then analyze the sample and record results on the Veliger Monitoring
Laboratory Form (Attachment B).

C. The QA Officer (or designee) then runs a sample through the FlowCAM in accordance with
SOP 1.12: Sample Processing by FlowCAM and SOP 1.13: Sample Post-Processing by
VisualSpreadsheet and counts the number of veligers imaged.

D. The technicians, in turn, look through the collage images to determine the number of
images veligers and record their findings on the Veliger Monitoring Laboratory Form
(Attachment B).

E. The QA Officer then compares the results and writes an Internal Audit for Precision
Report.

The Internal Audit of Precision Report contains: 1) A copy of each technician’s Veliger
Monitoring Laboratory Form (Attachment B); 2) A conclusion. The audit passes if all of
the technicians’ results are reasonably close in veliger counts. If the audit fails a
corrective action report must be written.

F. The Internal Audit for Precision Report must be retained by the QA Officer.
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Attached Documentation:
Veliger Monitoring Laboratory Form (B)

Demonstration of Capability Certification Statement (Q)
Demonstration of Capability Notes (R)

SOP 3.02: Demonstration of Capability

.

1.

Summary

A key component in the Glen Canyon Microscopy Laboratory’s Quality Assurance Plan is the
performance of a Demonstration of Capability (DOC) Test by each technician. Annually, each
technician must perform a DOC before independently performing laboratory techniques.

Equipment

Axiostar plus Zeiss Compound Microscope

FlowCAM

Previously analyzed plankton samples

Veligers to spike sample(s)

Plankton sample processing and analysis equipment (Refer to SOPs 1.07-1.13)

Procedures

A. The Quality Assurance (QA) Officer or Laboratory Supervisor will need to set up a
Demonstration of Capability Test when a laboratory technician has completed their
training (Refer to SOP 4.03: Laboratory Technician Training).

B. Priorto the test, the QA Officer or Laboratory Supervisor selects three previously
analyzed plankton samples with Dreissenid veligers.

C. Under the supervision of the QA Officer, the technician must prepare the plankton
samples as if they were a routine plankton sample.

D. The plankton samples must then be analyzed using the compound microscope and
FlowCAM by the technician to determine the presence or absence of Dreissenid veligers in
each of the three samples (Refer to SOPs 1.07-1.13).

E. Results must be recorded on the Veliger Monitoring Laboratory Form (Attachment B).
Also, fill out the Demonstration of Capability Notes (Attachment R).

F. The QA Officer compares the results achieved with the results expected. If the results do
not match, the test is failed — the QA Officer must write a Corrective Action Report
(Attachment 1) which identifies the problem and the technician must take another
Demonstration of Capability Test.
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G. Upon successful completion of the DOC Test, the Laboratory Director and QA Officer must
properly complete a DOC Certification Statement (Attachment Q) for the technician.

H. All documentation of this process, expected results, achieved results, laboratory notes,
and the DOC Certification Statement must be retained by the QA Officer in the
Demonstration of Capability binder. A copy of the DOC must be given to the technician.
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Attached Documentation:
Signature Sheet and Ethical Policy Attestation (P)

SOP 3.03: Data Integrity System

.

Summary

The Glen Canyon National Recreation Area Laboratories’ data integrity system consists of
several components. All laboratory personnel must annually complete Data Integrity
Training, provide their official signature and initials that will be used on all required laboratory
documentation, and sign an ethical policy attestation statement. Laboratory management is
responsible for in-depth periodic monitoring of data integrity and maintaining a procedure for
employees to report data integrity issues.

Procedures

A. Data Integrity Training is provided to new laboratory personnel and annually for all
current personnel by laboratory management. An attendance sheet must be signed by
those in attendance.

B. Topics covered in Data Integrity Training must include a discussion of how and when to
report data integrity issues, record keeping, and the organizational mission and its
relationship to the critical need for honesty and full disclosure in analytical reporting.

C. Following Data Integrity Training, new personnel must provide their official signature and
initials that will be used on all required laboratory documentation. All personnel must
sign an Ethical Policy Attestation (Attachment P) that states:

“I will uphold the commitments of the Glen Canyon National Recreation Area Microscopy
Laboratory as listed in the Quality Manual. | hereby acknowledge that the falsification of
data is unethical, and I shall not do so while working in Glen Canyon National Recreation
Area Laboratories. | understand that not upholding the aforementioned commitments
and/or behaving unethically may lead to my termination. | understand that any deviation
from a Standard Operating Procedure must be documented with a corrective action report.”

D. Copies of official signatures, initials, and Ethical Policy Attestations must be retained by
the employee and laboratory management.
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Laboratory management assures a receptive environment in which all employees may
privately discuss ethical issues or report items of ethical concern. Potential issues will be
handled in a confidential manner unti! a follow up evaluation, investigation, or other
appropriate actions have been completed and the issues clarified.

An employee may report an ethical concern either verbally or in writing to the Laboratory
Director or Quality Assurance Officer.

It is the responsibility of the laboratory management to investigate and take action in
response to any reports of unethical behavior. Findings of inappropriate activity must be
documented and include any disciplinary actions involved, corrective actions taken, and
notification to the client.

Other Quality Assurance activities such as the Quality Assurance Audits (SOP 4.07) also
provide opportunities to detect unethical behavior.

Unethical behavior will result in a detailed investigation that could lead to disciplinary
action including termination.
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Attached Documentation:
Signature Sheet and Ethical Policy Attestation (P)
Example Data Sheet (V)

SOP: 4.01 Recording Data

I

Summary

Guidelines for recording data are described below.

Procedure

A.

B.

Record data directly, promptly, and legibly in permanent black ink.

All data sheets will have a minimum left margin of 0.8 inches. Additional space needs to
be left at the bottom of data sheets for any notes or entry errors that need to be
recorded. No entries are to be made in the left-hand margin.

When recording data, one should sign his/her initials as they appear on the Signature
Sheet (Attachment P).

Changes in data shall be made by crossing out any errors with a single line so as not to
obscure the original entry. Place an asterisk paired with a number beside the crossed-out
entry to indicate the footnote with the corrected record. The correction footnote must
indicate the reason for correcting the record, the information to correct the record, and
be dated and initialed by the technician. See the attached Example Data Sheet
(Attachment V) for examples of data entries and changes to entries.

When recording time of events use Mountain Standard Time (Arizona, no daylight
savings) on a 24-hour clock. For example, one thirty in the afternoon would be recorded
as "1330".

Record dates as day month year with the month written out or abbreviated. Do not
indicate the month with numbers. For example, the 4™ of July in 2010 would be recorded
as "04 Jul 10" or "04 July 10". (Note: the year can also be written outas 4 digits.)
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G. There should be no blank spaces on a completed data sheet. Where applicable, enter "x",
"0" "N/A", or place a straight line through the blank space if a field is not applicable.
Using a ruler, cross out (X) or draw a line through the remainder of any unused portion of
the data sheet.

H. All data generated must be retained. The Quality Assurance Officer will review all of the
data before it is archived.
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Attached Documentation:
Plankton Tow Datasheet (A)
Veliger Monitoring Laboratory Form (B)

SOP 4.02: Data Entry in Microsoft Access

Summary

Plankton Tow Datasheets, Veliger Monitoring Laboratory Forms and any maps associated with
sampling are stored in the Veliger Monitoring Data binder. The field and laboratory data is
entered into the Veliger Monitoring database computer file on the U: drive. The procedure
for entering data is described below.

Equipment

Computer with network access

Procedures

A. A properly trained Laboratory Technician must log onto the Glen Canyon network.

B. Open the current Veliger Monitoring database in Microsoft Access. The database is
located at U:\Resources\Aquatic\WaterLab\Veliger Sampling\Veliger Monitoring
Database.

C. Obtain the data sheets (Attachments A and B) from the Veliger Monitoring binder.

D. Open the table "Plankton Tow Data" to enter data from the Plankton Tow Datasheet
(Attachment A).

E. Open the table "Analysis" to enter data from the Veliger Monitoring Laboratory Form
(Attachment B).

F. Enter the requested information into each of the tables using the data recorded on the
associated Plankton Tow Datasheets and Veliger Monitoring Laboratory Forms.

G. The Veliger Monitoring Database should be updated monthly to keep track of plankton
samples collected and analyzed by microscope and FlowCAM.
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Attached Documentation:
Microscopy Laboratory Training Document (1)

SOP 4.03: Laboratory Technician Training

1.

.

Summary

Laboratory technicians must be adequately trained in the methods and procedures of the
laboratory. A Training Document is used to record training in specific methods and
procedures. Laboratory personnel must successfully complete a Demonstration of Capability
before performing analysis techniques unsupervised. Laboratory management must maintain
records of all laboratory personnel that include qualifications, experience, training records,
Demonstration of Capabilities, Signature Sheet and Ethical Policy Attestations, and
documentation of any courses or workshops attended.

Equipment

Laboratory Quality Manual
Current SOPs

Procedures

A. New laboratory personnel must be given a copy of the current Microscopy Laboratory
Quality Manual and current Standard Operating Procedures. Additionally, a copy of this
manual is available in the laboratory at all times.

B. The Laboratory Technician must read and understand this manual.

C. A Microscopy Laboratory Training Document (Attachment 1) is used to record training in
specific methods and procedures that are needed by an employee to perform their
duties.

D. The Laboratory Director, QA Officer, or a previously trained technician must train new
technicians in each procedure. It is the responsibility of the trainer to observe and review
the work of the new technician.

E. The date of initial training will be recorded on the technician’s Training Document.
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F. When the trainer feels the trainee can perform the procedure unsupervised, the trainer
will sign and date the Training Document.

G. When the trainee feels that they can perform the procedure unsupervised, the trainee
will sign and date the Training Document.

H. Training Documents must be completed and maintained for all key personnel and
technicians. Each technician is responsible for making sure their training record is
accurate and current. Each technician must give a copy of their Training Document to the
Laboratory Director and Quality Assurance Officer whenever the document is updated.

I. Each technician must complete a Demonstration of Capability successfully (refer to SOP
3.02) for each method before performing the procedure unsupervised.
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Attached Documentation:

Plankton Sampling and Microscopy Supply Log (F)
Plankton Sampling Supplies Sent To Bullfrog (G)

SOP 4.04: Maintaining a Lab Supply Log and Chemical Inventory

Summary

An accurate record of all plankton sampling, microscopy, and FlowCAM supplies and
chemicals must be kept for future reference.

Procedures

A. Plankton Sampling and Microscopy Supply Log

1.

When supplies specifically for the Veliger Monitoring Program are received by the
laboratory, document the date received, technician initials, and description of each
item including company, quantity, lot number, and reason for ordering the item on the
Plankton Sampling and Microscopy Supply Log (Attachment F). When items are
received at the Bullfrog Laboratory, they are to be recorded in the Bullfrog Laboratory
Supply Log in the same fashion as in Wahweap.

When supplies are transferred from Wahweap to Bullfrog or vice versa, document the
date, items, quantity, company, lot number, and the method by which it was sent
(plane, boat, vehicle) on the Plankton Sampling Supplies Sent to Bullfrog (or Wahweap)
Log (Attachment G).

When chemicals and disposable labware are received write the date received and
technician initials on each box/container with a permanent marker. When these items
are opened write the date opened and technician initials on the box/container.

B. Chemical and Supplies Inventory

1.

The laboratory must maintain a Chemical and Supplies Inventory documenting all of
the chemicals and disposable items used in the lab. Items used for plankton sampling
and microscopy are documented in the Beach Monitoring Chemical and Supply
Inventory.
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When chemicals or disposable labware are received, the following will be
documented in the Chemical and Supplies Inventory: the name of the product,
manufacturer, lot number, maximum container quantity, current quantity, received
date, opened date, expiration date, and hazard warnings/special precautions.

There should be no blank spaces on a completed Chemical and Supplies Inventory

sheet. Enter "x","0", "N/A", or place a straight line through the blank space if a field
is not applicable.

The Chemical and Supplies Inventory is an electronic document that will be printed
out as a hard copy as it is updated.

The Chemical and Supplies Inventory will be updated as needed and a hard copy will be
filed in the Supply Log. The Chemical and Supplies Inventory is used to order needed
products.
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Effective Date _ 0RAUG 20\\p
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Attached Documentation:
Corrective Action Index (J)
Corrective Action Report (K)
Preventive Action Index (L)
Preventive Action Report (M)

SOP 4.05: Corrective and Preventive Actions

Summary

All activities conducted by laboratory personnel with concern to the Veliger Monitoring
Program are outlined in the Quality Manual. The Quality Manual consists of an annual Quality
Assurance Manual and all current Standard Operating Procedures. Corrective Action is taken
for nonconforming work, departures from the Quality Manual, and equipment malfunctions.
Preventive Action is a pro-active process to identify opportunities for improvement. All staff
members are responsible for conducting corrective and preventive actions. When a
corrective or preventive action is identified, a Corrective or Preventive Action Report is
completed and given to the Quality Assurance Officer. After monitoring the results, the
Quality Assurance Officer determines if they are acceptable. If they are not acceptable, a new
action report must be completed.

Procedures
A. Corrective Action:

1. Identify the nonconforming work, departure from the Quality Manual, or the
equipment malfunctions.

2. Create a log entry in the Corrective Action Index (Attachment J) by filling in the
discovery date, corrective action number (CA#), and subject. The CA# must be the
two digit year followed by the next whole number (for example: 11-001).

3. Create a Corrective Action Report (Attachment K) using the same date, CA#, and
subject as in the Corrective Action Index. Also, record the problem, cause, records
affected (including previous records), and technician initials.

4. Record the CA# on any affected record.
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5. If possible, record any potential solutions to the problem, the solution selected for
implementation and date of implementation, outcome, and technician initials. Refer
to equipment manuals for possible solutions.

6. Inform the Laboratory Supervisor, Quality Assurance Officer, and the Laboratory
Director of the situation.

7. Deliver photocopies or send electronic copies of the Corrective Action Report to the
Laboratory Director and the Quality Assurance Officer.

8. The Quality Assurance Officer must monitor the results and determine if they are
acceptable, as well as initial, and date all Corrective Action Reports and the Corrective
Action Index promptly. If the results are not acceptable, a new Corrective Action
must be taken, and the unsatisfactory report must refer to the new CA#.

9. The Quality Assurance Officer must photocopy the reviewed report and deliver it to
the Aquatic Ecologist.

10. Procedure for equipment malfunction:
a. ldentify the equipment malfunction.

b. Place a note on the equipment identifying the malfunction. Until the equipment
is repaired, it may not be used.

c. Follow steps 2 through 9 in Section A.

d. The effect of the equipment malfunction on previous tests must be examined.
New Corrective Action Reports are necessary if previous tests may have been
affected.

e. After the equipment has been repaired, return the equipment to service and
remove the malfunction note. Repairs must be noted in the Equipment
Maintenance logbook.

B. Preventive Action:
1. ldentify an area for improvement.

2. Create a log entry in the Preventive Action Index (Attachment L) by filling in the
discovery date, preventive action number (PA#), and subject. The PA# must be the
two digit year followed by the next whole number (For example: 11-001).
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Create a Preventive Action Report (Attachment M) using the same date, PA#, and
subject as in the Preventive Action Index. Also, record the area in need of
improvement, reason, records affected, and technician initials.

Record the PA# on any affected record.

If possible, identify potential improvements, the improvement selected for
implementation and date of implementation, outcome, and technician initials. Refer
to equipment manuals for possible solutions.

Inform the Laboratory Supervisor, Quality Assurance Officer, and the Laboratory
Director of the situation.

Deliver photocopies or send electronic copies of the Preventive Action Report to the
Laboratory Director and the Quality Assurance Officer.

The Quality Assurance Officer must monitor the results and determine if they are
acceptable, as well as initial, and date all Preventive Action Reports and the
Preventive Action Index promptly. If the results are not acceptable, a new Preventive
Action must be taken, and the unsatisfactory report must refer to the new PA#.

The Quality Assurance Officer must photocopy the reviewed report and deliver it to
the Laboratory Director.
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Approved By W}’V/@
%Wa;mmm
Attached Documentation:
Equipment Documentation (H)
Wahweap Outer Laboratory Map (U)

Equipment Maintenance and Cleaning Log (S)
Corrective Action Report (K)

SOP 4.06: Equipment Documentation

I, Summary

The laboratory is furnished with all the items needed to perform microscopic analyses and to
perform quality control activities. All equipment is maintained in good working order. Each
piece of equipment is documented and uniquely identified by a serial number and/or National
Park Service property number. Documentation is maintained in the Equipment Maintenance
Log. If a piece of equipment performs unsatisfactorily, the instrument is removed from
service, tagged, and repaired with proper documentation.

II. Equipment

All microscopy laboratory equipment
Ill. Procedures

A. Laboratory Equipment

1. An Equipment Documentation Form (Attachment H) must be maintained for each
piece of equipment. Information on this form includes: the date, preparer’s name,
name of item, manufacturer name, model number, serial number, NPS property
number, electrical information, location of the manufacturer’s instructions {must be
within the laboratory building), date received, condition when received, date placed
in service, current physical location, date and description of each maintenance
activity, and date and description of each repair. The current physical location must
be indicated on the Wahweap Outer Laboratory Map (Attachment U).

2. The equipment documentation must be current. Any changes to the status of the
equipment must be documented on the Equipment Documentation form.
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3. Whenever equipment performs unsatisfactorily, a Corrective Action Report
(Attachment K) must be completed. Refer to SOP 4.05: Corrective and Preventative
Actions.

4. All equipment must be cleaned regularly. Cleaning dates must be recorded in the
Equipment Maintenance and Cleaning Log (Attachment S).

Page 2 of 2



SOP 4.07 Issue 1
Effective Date __ O BAUGIO
Approved By ;%A/K—Q%—A——\
7 7
wLO

Attached Documentation:
Quality Assurance Audit (O)
Corrective Action Report (K)

SOP 4.07: Quality Assurance Audits, Managerial Review, and the Quality Manual

Summary

The combination of Monthly Quality Assurance Audits, annual Managerial Reviews, and the
Quality Manual are the centerpieces of the Microscopy Laboratory’s Quality System. The
Monthly Quality Assurance Audits ensure that laboratory management is aware of the work
being conducted in the laboratory. The annual managerial review evaluates the continuing
suitability and effectiveness of the Veliger Monitoring Program along with any changes or
improvements to the program. The Quality Manual describes all policies and procedures to
ensure and document the quality of the analytical data.

Procedures

A. Monthly Quality Assurance Audits

1. When the Microscopy Laboratory is in operation, the QA Officer must review the
work conducted on a monthly basis.

2. All forms must be checked for proper documentation and usage errors. The
following must be reviewed: Corrective and Preventive Action Reports, Veliger
Monitoring Laboratory Forms, Plankton Tow Datasheets, and Equipment
Maintenance and Cleaning Logs.

3. Errors discovered on the forms, with the exception of transcription errors, must be
corrected through the use of Corrective Action Reports {Attachment K). Refer to
SOP 4.05: Corrective and Preventive Actions.

4. The QA Officer records "Proofed” followed by the date, and initials on every log that
has been reviewed. If the log sheet is only partially used, the QA Officer draws a line
and records the information above it or notes the area and records the information
at the bottom of the sheet.

5. Monthly Quality Assurance Audits should be kept as both electronic and hard
copies. '
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B. Managerial Review
1. Annually the Laboratory Director or delegate must complete a Managerial Review.

2. This document reviews the quality assurance and analytical activities to ensure their
continuing suitability and effectiveness. Furthermore, it documents that the Quality
Manual was up to date and met any new work requirements necessary for the
volume and type of work undertaken.

3. The Managerial Review must include the following topics:

a. A summary of quality assurance activities and results including: Monthly Quality
Assurance Audits, Corrective and Preventive Actions, Demonstration of
Capabilities, Internal Audits for Precision, and Equipment Maintenance.

b. A summary of laboratory activities and assessments, and any other comments
from external bodies.

c. A summary of Standard Operating Procedure alterations that have occurred
since the last Managerial Review.

d. A summary to indicate that the Quality Manual continues to meet necessary
standards.

4. The Laboratory Director and QA Officer must sign and date the final version of the
Managerial Review.

C. Quality Manual

1. Itis the responsibility of the QA Officer to create and submit to the Laboratory
Director necessary changes to any areas of the Quality Manual.

2. All areas of the Quality Manual must be uniquely identified by including the date of
issue, page numbering, and the total number of pages.

3. The Laboratory Director and QA Officer must sign and date the final version of the
Quality Manual.
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Attached Documentation:
Corrective Action Report (K)
Correspondence Index (N)

SOP: 4.08 Complaint and Correspondence Policy

l.  Summary

This policy has been created in order to serve the Microscopy Laboratory’s client and outside
parties better. The Correspondence Index serves as a record of solicited client feedback,
unsolicited correspondence, as well as a record of all correspondences occurring between
laboratories, clients, and other outside parties. The Correspondence Index and associated
documentation is stored in the Correspondence Logbook in the Laboratory Director’s office.

iI. Procedure

A. Inthe event staff should receive a comment (including complaints) about the Microscopy
Laboratory, staff members should instruct the addresser to write a letter with return
address information and send it to:

Glen Canyon NRA

Lake Powell Water Laboratories, Laboratory Director
P.0O. Box 1507

Page, AZ 86040

B. The Laboratory Director responds to all incoming correspondence.

C. All correspondences, incoming and outgoing (solicited or unsolicited), must be properly
documented in the Correspondence Index (Attachment N). The date of incoming or
outgoing correspondence, correspondence ID number (CID), "To" or "From" must be
indicated under contact information along with the address (if available) of the contact,
and subject of the correspondence must be entered into the Correspondence Index.

1. All hard copies of correspondences must be stored in the logbook, chronologically, by
CID number with newest correspondences in the back of the logbook.
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A correspondence ID number is assigned using "CID" and the current two digit year
followed by the next whole number (example: CID 11-001). The correspondence ID
number must also be indicated on the hard copy of the correspondence. If the
correspondence is a response to or continuation of a previous correspondence, the
correspondence ID number will be that of the original correspondence followed by
the next lowercase letter (example: 11-001a, 11-001b, etc).

If the nature of the written correspondence is casual or in memoranda form, such as
e-mail notifications or facsimile transmissions, a hard copy of the correspondence
must be entered into the Correspondence Index. In the case of verbal
correspondences, a synopsis of the correspondence must be synthesized and entered
into the Correspondence Index.

If the correspondence addresses a previously unknown laboratory problem, a
Corrective Action Report (Attachment K) must promptly be completed and included
with the correspondence. Refer to SOP 4.05: Corrective and Preventative Actions.

If an official-type response is required, the response must be drafted and given to the
Resource Management Secretary to finalize so that National Park Service
correspondence guidelines are met.

The response must be signed and sent to the addresser.

Laboratory Director’s initials, Glen Canyon Response Number (if an official response),
and CA# must be recorded in the Correspondence Index. Draw a single line through
the CA# box if corrective action or official response was not necessary.

Copies of all correspondence must be retained in the Correspondence Logbook under
the CID Number and Glen Canyon Response Number (if applicable).
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Attached Documentation:
Current SOP Log (Y)

SOP 4.09: SOP Creation and Revision

Summary

A Standard Operating Procedure (SOP) is maintained for each common laboratory activity. If
ever the Microscopy Laboratory institutes or changes a procedure, a new SOP or revision
must be created. Each SOP has an effective date and issue number, and is signed by the
Laboratory Director and QA Officer. The laboratory and all laboratory personnel must possess
a current edition of the laboratory SOPs. A list of current issue numbers is maintained and
displayed to keep all copies of the SOP current. As part of the document control system, old
issues are stored at the Glen Canyon National Recreation Area Headquarters building for at
least five years. All staff must follow SOPs without deviation, if there is a deviation from a
SOP, a Corrective Action Report must be completed. Refer to SOP 4.05: Corrective and
Preventative Actions. Technical errors within an SOP should be brought to the Laboratory
Director and QA Officer’s attention immediately, and a Corrective Action Report must be
completed. Grammatical errors should be highlighted and given to the QA Officer. The QA
Officer reviews all of the SOPs annually.

Procedures

A. The QA Officer must create a new SOP or revision every time a procedure is instituted or
changed. Electronic copies of the SOPs are maintained on the Glen Canyon NRA
computer network.

B. The Laboratory Director must review the document.

C. When the document is error-free the QA Officer and Laboratory Director sign and record
the effective date on the SOP.

D. The Current SOP Log (Attachment Y) must be updated along with the Quality Manual if
necessary.

E. The QA Officer must photocopy the SOP and the Current SOP Log and distribute copies to
all laboratory personnel.
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F. The QA Officer must remove the old version of the SOP from the Master SOP file and
placed it into the Old SOP file.

G. The new SOP is placed into the Master SOP file.
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